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Regulatory Compliance

The CY8CKIT-041-40XX PSoC® 4 S-Series Pioneer Kit is intended for use as a development
platform for hardware or software in a laboratory environment. The board is an open system design,
which does not include a shielded enclosure. This may cause interference to other electrical or
electronic devices in close proximity. In a domestic environment, this product may cause radio
interference. In such cases, you may be required to take adequate preventive measures. In addition,
this board should not be used near any medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures should be taken.

The PSoC 4 S-Series Pioneer Kit, as shipped from the factory, has been verified to meet with the
requirements of CE as a Class A product.

C€

Az

The PSoC 4 S-Series Pioneer Kit contains electrostatic discharge (ESD) sensitive
devices. Electrostatic charges readily accumulate on the human body and any
equipment, and can discharge without detection. Permanent damage may occur on
devices subjected to high-energy discharges. Proper ESD precautions are
recommended to avoid performance degradation or loss of functionality. Store unused
PSoC 4 S-Series Pioneer kit in the protective shipping package.

E

End-of-Life/Product Recycling

The end-of life for this kit is five years from the date of manufacture mentioned as bar
code on the back of the box. Contact your nearest recycler for discarding the kit.

General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that you perform
procedures only at an ESD workstation. If an ESD workstation is not available, use appropriate ESD
protection by wearing an antistatic wrist strap attached to a grounded metal object.

Handling Boards

PSoC 4 S-Series Pioneer Kit is sensitive to ESD. Hold the board only by its edges. After removing
the board from its box, place it on a grounded, static-free surface. Use a conductive foam pad if
available. Do not slide the board over any surface.
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Thank you for your interest in the CY8CKIT-041-40XX PSoC® 4 S-Series Pioneer Kit. This kit
enables you to evaluate and develop your application using the PSoC 4000S device family.

The PSoC 4000S device family is an expansion to the PSoC 4 device family. PSoC 4000S device is
a true programmable embedded system-on-chip, integrating custom analog and digital peripheral

functions, memory, and an ARM® Cortex®-M0+ microcontroller on a single chip. The programmable
analog and digital peripheral functions allow higher flexibility, in-field tuning of the design, and faster
time-to-market.

The PSoC 4 S-Series Pioneer Kit offers footprint-compatibility with Arduino™ shields. This kit
features a CapSense® trackpad, two CapSense buttons, a CapSense proximity sensor that lets you
evaluate Cypress’s fourth-generation CapSense technology, an RGB LED, two user-configurable
push-button switches, potentiometer, an onboard programmer/debugger with USB-UART/I2C bridge
functionality block (KitProg2), a Cypress F-RAM™, an EZ-BLE™ PRoC™ Module, and a
rechargeable battery. This kit supports operating voltages of 1.9V, 3 V (battery), 3.3V or 5 V.

You will use PSoC Creator™ to develop and debug your PSoC 4000S device projects. PSoC
Creator is Cypress’s standard integrated design environment (IDE). If you are new to PSoC Creator,
see the documentation on the PSoC Creator home page. You can also refer the application note
AN79953 — Getting Started with PSoC 4, which gives an introduction to the PSoC 4 device.

1.1 Kit Contents

The CY8CKIT-041-40XX PSoC 4 S-Series Pioneer Kit contains the following, as shown in
Figure 1-1.

m PSoC 4 S-Series Pioneer Kit

USB Standard-A to Micro-B cable

Water dropper

Four press-fit connectors (one 8x2, one 10x1, two 8x1)
Four jumper wires

Quick Start Guide

PSoC® 4 S-Series Pioneer Kit Guide, Doc. # 002-10238 Rev. *D 5
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Figure 1-1. Kit Contents
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Inspect the contents of the kit; if you find any part missing, contact your nearest Cypress sales office
for help: www.cypress.com/support.

1.2 Board Details

As shown in Figure 1-2, the PSoC 4 S-Series Pioneer Kit features a CapSense trackpad, two
CapSense buttons, and a proximity sensor loop (not visible on the case) that lets you evaluate
Cypress’s fourth-generation CapSense technology. The kit has two user buttons, an RGB LED and a
potentiometer that can be used in your applications. It also has a reset button and three status LEDs.
The kit can be powered from three power sources: USB connector, rechargeable battery or external
power supply. The kit can operate at 1.9V, 3.3V, and 5 V when powered from the USB connector or
external power supply and will operate at 3 V when powered from the battery. The USB connector is
also used for programming and debugging your application on PSoC 4000S.

PSoC® 4 S-Series Pioneer Kit Guide, Doc. # 002-10238 Rev. *D 6
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Figure 1-2. PSoC 4 S-Series Pioneer Kit

1. KitProg2 Status LEDs 4. Potentiometer
2. Power LED 5. Reset button
3. KitProg2 USB Micro-B connector 6. User button

7. KitProg?2 user button
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Figure 1-3. PSoC 4 S-Series Pioneer Kit without Overlay

P/ Cyrress

PERFORM

CY8CKIT-041-40XX
PSoC 4 S-SERIES PIONEER KIT

1. CapSense trackpad

2. CapSense buttons

3. Proximity sensor loop

Note: The above figure shows the kit without color gamut overlay
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Figure 1-4. PSoC 4 S-Series Pioneer board (Top View)
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1. KitProg2 USB Micro-B connector (J6) 14. RGB LED (LEDS)
2. KitProg2 status LEDs (LED1, LED2 and LED3) 15. KitProg2 user button (SW3)
3. External power supply header (J7) 16. Rechargeable battery (ML2430-HS1, V2)
4. KitProg2 (PSoC 5LP) I/O header (18) 17. User Button (SW2)
5. Power LED (LED4) 18. Reset button (SW1)
6. System power (VDD) selection switch (SW6) 19. Arduino ICSP compatible header (112)
7. KitProg2 custom application/programming header (J)11) ~ 20. EZBLE™ PRoC™ Module (CYBLE-022001-00, U3)
8. Voltage regulator circuit 21. Potentiometer (R2)
9. PSoC 4000S 10-pin program and debug header (J13) ~ 22. VDD source selection switch (SW4)
10. Arduino™ compatible power and 1/O headers 23. Current measurement selection switch (SW7)
P1,J2,J3 and J4) 24. PSoC 40008 (U1)
11. 32.768 kHz crystal oscillator (Y1) 25. Programming target (PSoC 4000S/EZ-BLE PRoC) module
12. Voltage Level Translator for F-RAM (U14) selection switch (SW5)
13. Cypress FRAM 1Mb (FM24V10G, U11) 26. KitProg2 (PSoC 5LP) programmer and debugger (U15)
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Figure 1-5. PSoC 4 S-Series Pioneer board (Bottom View)
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Figure 1-6. PSoC 4 S-Series Pioneer Board Pinout
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Table 1-1. Jumpers/Switches Default Position

Jumper/Switch Purpose Default Position

SW4 (PWR SEL) [VDD Source Selection EXT (VREG/VBUS)
SW5 Programming Target Selection PSoC 4000S
SW6 System Power (VDD) Selection 5V

SW7 Current Measurement Selection Switches P1, P2, P3, and P4 — OFF;
Switch P5 - ON

1.3 PSoC Creator

PSoC Creator is a state-of-the-art, easy-to-use IDE. It introduces revolutionary hardware and soft-
ware co-design, powered by a library of fully verified and characterized PSoC Components™, as
shown in Figure 1-7. With PSoC Creator, you can:

1. Drag and drop Components to build your hardware system design in the main design workspace
Co-design your application firmware with the PSoC hardware

Configure Components using configuration tools

Explore the library of 100+ Components

Access Component datasheets

oD

Figure 1-7. PSoC Creator Features
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PSoC Creator also enables you to tap into an entire tool ecosystem with integrated compiler chains
and production programmers for PSoC devices.

For more information, visit www.cypress.com/psoccreator.
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1.3.1 PSoC Creator Code Examples

PSoC Creator includes a large number of code examples. These examples are accessible from the
PSoC Creator Start Page, as shown in Figure 1-8.

Code examples can speed up your design process by starting you off with a complete design. The
code examples also show how to use PSoC Creator Components for various applications. Code
examples and documentation are included, as shown in Figure 1-9.

In the Find Code Example dialog shown in Figure 1-9, you have several options:

Filter for examples based on device family or keyword.

Select from the list of examples offered based on the Filter Options.

View the project documentation for the selection (on the Documentation tab).

View the code for the selection on the Sample Code tab. You can also copy and paste code from
this window to your project, which can help speed up code development.

m Create a new workspace for the code example or add to your existing workspace. This can speed
up your design process by starting you off with a complete, basic design. You can then adapt that
design to your application.

Figure 1-8. Code Examples in PSoC Creator
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Product Information
PSoC Creator
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Figure 1-9. Code Example with Sample Code
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m——
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CE210292_WDT_P4S_Example = £ZI2C_EzI2CSetBufferl (sizeof (CapSense d
CE210487 E
CE210488 /% Start UART block */
CE210489 URRT_Start();
CE211584 ) B ) )
Clock_P4_Example /* Set LED b:'_?'.’.t,:ess to zero */f
LED CONTROL WriteCompare (PWM MIN) ;
Flash_Example - - -

12C_LCD_Example_PSoC4
Interrupts_Example
LPComparator_PSoC4_Example

/% Btart PWM block */
LED CONTROL Start():

PWMExample * Start CapSense ADC component ¥,

QuadDecExample CapSense_Start();

RTC_P4_SysTick_Exarmple o

SCB_Ezl2cCommsSlave =l < [T} 3
Create Project ] l Cancel

1.3.2 Kit Code Examples

You can access the installed kit code examples from the PSoC Creator Start Page. To access these
examples, expand the Kits under the section Examples and Kits; then, expand the specific kit to see
the code examples. Refer to the Code Examples chapter on page 32 for a list of code examples that
you can use on this kit.

1.3.3 PSoC Creator Help

Launch PSoC Creator and navigate to the following items:

Quick Start Guide: Choose Help > Documentation > Quick Start Guide. This guide gives you
the basics for developing PSoC Creator projects.

Simple Component Code Examples: Choose File > Code Example. These examples demon-
strate how to configure and use PSoC Creator Components. To access examples related to a
specific Component, right-click on the Component in the schematic or in the Component Catalog.
Select the Find Code Example option in the context menu that appears.

System Reference Guide: Choose Help > System Reference > System Reference Guide.
This guide lists and describes the system functions provided by PSoC Creator.

Component Datasheets: Right-click a Component and select Open Datasheet. Visit the

PSoC 4 Component Datasheets page for a list of all PSoC 4 Component datasheets.

Document Manager: PSoC Creator provides a document manager to help you easily find and
access the document resources. To open the document manager, choose the menu item Help >
Document Manager.
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1.4 Getting Started
This guide will help you be acquainted with the PSoC 4 S-Series Pioneer Kit:

The Software Installation chapter on page 17 describes the installation of the kit software. This
includes the PSoC Creator IDE to develop and debug the applications, and PSoC Programmer to
program the .hex files on to the device.

The Kit Operation chapter on page 20 describes the major features of the PSoC 4 S-Series Pio-
neer Kit and functionalities such as programming, debugging, and the USB-UART and USB-I2C
bridges.

The Code Examples chapter on page 32 describes multiple PSoC 4000S code examples that will
help you understand how to create your own PSoC 4 projects.

The Appendix on page 36 provides the detailed hardware description, method to use the onboard
F-RAM, method to use the on board EZ-BLE PRoC Module, kit schematics, and the bill of mate-
rials (BOM).

1.5 Additional Learning Resources

Cypress provides a wealth of data at www.cypress.com to help you to select the right PSoC device
for your design, and to help you to quickly and effectively integrate the device into your design. For a
comprehensive list of resources, see KBA86521, How to Design with PSoC 3, PSoC 4, and
PSoC 5LP. The following is an abbreviated list for PSoC 4:

Overview: PSoC Portfolio and PSoC Roadmap.

Product Selectors: PSoC 4 Product Selector. In addition, PSoC Creator includes a device selec-
tion tool.

Datasheets: Describe and provide electrical specifications for the PSoC 4000, PSoC 4100,
PSoC 4200, PSoC 4100M, PSoC 4200M, PSoC 4200L, PSoC 4000S and PSoC 4100S device
families.

CapSense Design Guide: Learn how to design capacitive touch-sensing applications with the
PSoC 4 family of devices.

Application Notes and Code Examples: Cover a broad range of topics, from basic to advanced.
Many of the application notes include code examples. Visit the PSoC 3/4/5 Code Examples web
page for a list of all available PSoC Creator code examples. To access code examples from
within PSoC Creator — see PSoC Creator Code Examples on page 12.

Technical Reference Manuals (TRM): Provide detailed descriptions of the architecture and regis-
ters in each PSoC 4 device family.

Development Kits:

o CYB8CKIT-041-40XX, CY8BCKIT-041-41XX, CY8CKIT-046, CY8CKIT-044, CY8CKIT-042 and
CY8CKIT-040 are easy-to-use and inexpensive development platforms. These kits include
connectors for Arduino-compatible shields. Additionally, CY8CKIT-046, CY8CKIT-044, and
CY8CKIT-042 include connectors for Digilent Pmod Peripheral Modules.

o CY8CKIT-049, CY8CKIT-043 and CY8CKIT-145-40XX are very low-cost prototyping platform
for sampling PSoC 4 devices.

0 CY8CKIT-001 is a common development platform for all PSoC family devices.
o  MiniProg3 device provides an interface for flash programming and debug.

Knowledge Base Articles (KBA): Provide design and application tips from experts on using the
device.

Visit www.cypress.com/training for a set of tutorials, including PSoC Creator training. Each tuto-

rial is a series of videos that provide practical examples on various topics starting with basic con-
cepts and moving on to more advanced features.

PSoC® 4 S-Series Pioneer Kit Guide, Doc. # 002-10238 Rev. *D 14


http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4000-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4100-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com
http://www.cypress.com/?id=4&rID=77024
http://www.cypress.com/?id=4&rID=77024
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=4749&applicationID=0&l=0
http://www.cypress.com/?rID=101641
http://www.cypress.com/search/all?f[0]=meta_type%3Atechnical_documents&f[1]=resource_meta_type%3A574&f[2]=field_related_products%3A1297
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4200-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4200-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4100m-family-datasheet
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4200m-family-datasheet
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=110&id=4749&applicationID=0&l=0
www.cypress.com/documentation/datasheets/psoc-4-psoc-4200l-family-datasheet
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4000s-family-datasheet
http://www.cypress.com/?rID=78578&source=an79953
www.cypress.com/CY8CKIT-041
www.cypress.com/CY8CKIT-046
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=118&id=4749&applicationID=0&l=0
www.cypress.com/CY8CKIT-046
www.cypress.com/CY8CKIT-044
www.cypress.com/CY8CKIT-044
http://www.cypress.com/CY8CKIT-042
www.cypress.com/cy8ckit-001
http://www.cypress.com/CY8CKIT-040
www.cypress.com/CY8CKIT-046
www.cypress.com/CY8CKIT-046
http://www.cypress.com/go/CY8CKIT-001
http://www.cypress.com/?id=4976
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4100s-family-datasheet
http://www.cypress.com/psoccreator
http://www.cypress.com/psoc
http://www.cypress.com/?rID=86788
www.cypress.com/CY8CKIT-044
www.cypress.com/CY8CKIT-044
http://www.cypress.com/search/all?f[0]=meta_type%3Asoftware_tools&f[1]=field_related_products%3A1297&f[2]=software_tools_meta_type%3A579
http://www.cypress.com/CY8CKIT-049
www,cypress.com/cy8ckit-043
http://www.cypress.com/CY8CKIT-002
www.cypress.com/CY8CKIT-043
http://www.cypress.com/CY8CKIT-145
www.cypress.com/CY8CKIT-042
www.cypress.com/CY8CKIT-041-41XX
www.cypress.com/training

o CYPRESS

N 4 EMBEDDED IN TOMORROW™

1.6 Technical Support

Introduction

For assistance, visit Cypress Support or contact customer support at +1(800) 541-4736 Ext. 2 (in the
USA) or +1 (408) 943-2600 Ext. 2 (International).

You can also use the following support resources if you need quick assistance:
m Self-help (Technical Documents)
m Local Sales Office Locations

1.7 Documentation Conventions

Table 1-2. Document Conventions for Guides

Convention

Usage

Courier New

Displays file locations, user entered text, and source code:
C:\...cd\icc\

Italics

Displays file names and reference documentation:

Read about the sourcefile.hex file in the PSoC Creator User Guide.

[Bracketed, Bold]

Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open

Represents menu paths:
File > Open > New Project

Bold

Displays commands, menu paths, and icon hames in procedures:
Click the File icon and then click Open.

Times New Roman

Displays an equation:
2+2=4

Text in gray boxes

Describes cautions or unique functionality of the product.

1.8 Acronyms
Table 1-3. Acronyms Used in this Document
Acronym Definition
ADC Analog-to-Digital Converter
BLE Bluetooth Low Energy
BOM Bill of Materials
CINT Integration Capacitor
CMOD Modulator Capacitor
CPU Central Processing Unit
CSD CapSense Sigma Delta
CTANK Shield Tank Capacitor
DC Direct Current
Del-Sig Delta-Sigma
ESD Electrostatic Discharge
F-RAM Ferroelectric Random Access Memory
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Table 1-3. Acronyms Used in this Document (continued)
Acronym Definition
FPC Flexible Printed Circuit
GPIO General-Purpose Input/Output
HID Human Interface Device
12C Inter-Integrated Circuit
IC Integrated Circuit
ICSP In-Circuit Serial Programming
IDAC Current Digital-to-Analog Converter
IDE Integrated Development Environment
LED Light-emitting Diode
PC Personal Computer
PTC Positive Temperature Coefficient
PRoC Programmable Radio-on-Chip
PSoC Programmable System-on-Chip
PWM Pulse Width Modulation
RGB Red Green Blue
SAR Successive Approximation Register
SPI Serial Peripheral Interface
SRAM Serial Random Access Memory
SWD Serial Wire Debug
UART Universal Asynchronous Receiver Transmitter
uUSB Universal Serial Bus
wCO Watch Crystal Oscillator
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This chapter describes the steps to install the software tools and packages on a PC for using the
PSoC 4 S-Series Pioneer Kit. This includes the IDE on which the projects will be built and used for
programming.

2.1 Before You Begin

To install Cypress software, you will require administrator privileges. However, they are not required
to run software that is already installed. Before you install the kit software, close any other Cypress
software that is currently running.

2.2 Install Software

Follow these steps to install the PSoC 4 S-Series Pioneer Kit software:

1. Download the CY8CKIT-041-40XX PSoC 4 S-Series Pioneer Kit software from
www.cypress.com/CY8CKIT-041. The kit software is available in three different formats for down-
load.

a.

CY8CKIT-041-40XX Kit Complete Setup: This installation package contains the files related
to the kit including PSoC Creator and PSoC Programmer. However, it does not include the
Windows Installer or Microsoft .NET framework packages. If these packages are not on your
computer, the installer directs you to download and install them from the Internet.

CY8CKIT-041-40XX Kit Only: This executable file installs only the kit contents, which include
kit code examples, hardware files, and user documents. This package can be used if all the
software prerequisites (listed in step 5) are installed on your PC.

CY8CKIT-041-40XX DVD ISO: This file is a complete package, stored in a DVD-ROM image
format, which you can use to create a DVD or extract using an ISO extraction program such

as WinZip® or WinRAR. The file can also be mounted like a virtual CD/DVD using virtual drive
programs such as Virtual CloneDrive and MagiclSO. This file includes all the required soft-
ware, utilities, drivers, hardware files, and user documents.

2. If you have downloaded the ISO file, mount it on a virtual drive. Extract the ISO contents if you do
not have a virtual drive to mount. Double-click cyautorun.exe in the root directory of the extracted
content or the mounted ISO if “Autorun from CD/DVD” is not enabled on the computer. The instal-
lation window will appear automatically.

Note: If you are using the “Kit Complete Setup” or “Kit Only” file, then go to step 4 for installation.
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3. Click Install CY8CKIT-041-40XX to start the PSoC 4 S-Series Pioneer Kit installation, as shown
in Figure 2-1.

Figure 2-1. Kit Installer Screen
= CYBCKIT-041-40XX o B |[==

PERFORM

CY8CKIT-041-40XX

Open User Guide ...

s Semiconductor Corporation. All rights reserved

4. Select the folder in which you want to install the PSoC 4 S-Series Pioneer Kit-related files.
Choose the directory and click Next.

5. When you click Next, the installer automatically installs the required software, if it is not present
on your computer. Following are the required software:
a. PSoC Creator 4.0 or later: This software is available for download separately at
www.cypress.com/psoccreator.
b. PSoC Programmer 3.25 or later: This is installed as part of PSoC Creator installation or is
available separately at www.cypress.com/programmer.

6. Choose the Typical, Custom, or Complete installation type (select Typical if you do not know
which one to select) in the Product Installation Overview window, as shown in Figure 2-2. Click
Next after you select the installation type.
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Figure 2-2. Product Installation Overview

& Cylnstaller for CYBCKIT-041-40X PSoC 4 5-5Series Pioneer Kit

Product Installation Overview
Choose the install type that best suits your needs

Choose the type of installation

Product:

CYBCKIT-041-400X PSoC 4 S-Series
Pioneer Kit

Instzllation Type:

Typica
Custom

Installs th
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Pioneer Kit.
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7. Read the License agreement and select | accept the terms in the license agreement to con-
tinue with installation. Click Next.

8. When the installation begins, a list of packages appears on the installation page. A green check
mark appears next to each package after successful installation.

9. Enter your contact information or select the check box Continue Without Contact Information.
Click Finish to complete the CY8CKIT-041-40XX PSoC 4 S-Series Pioneer Kit software installa-
tion.

10.After the installation is complete, the kit contents are available at the following location:
<Install Directory>\CY8CKIT-041-40XX PSoC 4 S-Series Pioneer Kit
Default location:

Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY8CKIT-041-40XX PSoC 4 S-
Series Pioneer Kit

Windows 7 (32-bit): C:\Program Files\Cypress\CY8CKIT-041-40XX PSoC 4 S-Series
Pioneer Kit

Note: For Windows 7/8/8.1/10 users, the installed files and the folder are read only. To use the
installed code examples, follow the steps outlined in the Code Examples chapter on page 32. These
steps will create an editable copy of the example in a path that you choose so the original installed
example is not modified.

Uninstall Software

The software can be uninstalled using one of the following methods:
m Go to Start > All Programs > Cypress > Cypress Update Manager and select the Uninstall
button that corresponds to the kit software.

m Go to Start > Control Panel > Programs and Features for Windows 7 or Add/Remove Pro-
grams for Windows XP; choose the product and select the Uninstall/Change button.
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This chapter introduces you to the various features of the PSoC 4 S-Series Pioneer Kit, including the
theory of operation and the onboard programming and debugging functionality, KitProg2 USB-UART

and USB-I2C bridges.

3.1 Theory of Operation

The PSoC 4 S-Series Pioneer Kit is built around the PSoC 4000S device. Figure 3-1 shows the
block diagram of the PSoC 4000S device.

Figure 3-1. PSoC 4000S Block Diagram
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Given below is a list of major features of PSoC 4000S device.
m 32-Bit MCU Subsystem
o 48-MHz ARM® Cortex®-M0+ CPU
o Up to 32KB flash, 4KB SRAM
o Real-time clock capability with a WCO
m Programmable Analog Blocks
a One 10-bit, 46.8-Ksps Single-Slope ADC
o Two low-power comparators (CMP)
o One CapSense® block that supports low-power operation with self- and mutual-capacitance
sensing
o Two 7-bit IDACs configurable as a single 8-bit IDAC
m Programmable Digital Blocks
a Five 16-bit Timer, Counter, PWM (TCPWM) blocks
o Two serial communication blocks (SCBs) that are configurable as 12C, SPI or UART
m Packages
o 25-ball WLCSP, 24-pin QFN, 32-pin QFN, 48-pin TQFP
a Up to 36 GPIOs, including 16 Smart I/Os

Refer to the PSoC 4000S datasheet for details on device features.
Figure 3-2 shows the block diagram for the PSoC 4 S-Series Pioneer Kit.
Figure 3-2. Block Diagram of PSoC 4 S-Series Pioneer Kit

Power LED EZ-BLE

33v sy Reset

Battery

Charging Coin cell

6~12Vv

Voltage

Res::;zble Regulator Sle'r \:Pn v;)li sz:_ur:e Arduino Comp(atihl:_Plt:’V)ver
PMI election election Connectors (to shie
(Cypress c) (switch) (switch)
Regulator control VN 12¢
(ON/OFF)
Regulator SWD Kitprog2/
Power Supply Switch  PSoC 40005

ON/OFF control

3.3V
(DIP switch)
Voltage Monitor
(VBUS/VTARG) 12€ Pullup Level
Regulator Via MOSFET Translator

Resettable ON/OFF control
12C ypp
12¢ ¢
KitProg2 12C / UART / SPI

(Micro- B) (PSoC 5LP)
SWD / Reset

Reset

Protection
Status LEDs SPI Header
PSoC 5LP GPIO Button (3x2)
Header EZ-BLE
General Purpose
User Button PSoC 5LP Custom External 1/0 Connectors
Prog/Debug

RGB LED

wco
(32.768KHz)

EZ-BLE

User
Button

Potentio
meter

CapSense Flex
Trackpad and
Buttons

PSoC 4000S

Application Header
PSoC 5LP
Arduino Compatible 1/0
KitPl’ng A PSoC 40005

Signal bus
_— Power
_— Signal

PSoC® 4 S-Series Pioneer Kit Guide, Doc. # 002-10238 Rev. *D 21



www.cypress.com/documentation/datasheets/psoc-4-psoc-4000s-family-datasheet

o CYPRESS

~amp” EMBEDDED IN TOMORROW" Kit Operation

The PSoC 4 S-Series Pioneer Kit comes with a case that houses the PSoC 4 S-Series Pioneer
board (main board) and a Flex PCB. Refer to How to open the Kit Case chapter on page 26 for
details on opening the case.

Figure 3-3 shows the markup of PSoC 4 S-Series Pioneer board and the CapSense Flex PCB.
Figure 3-3. PSoC 4 S-Series Pioneer Board and Flex PCB

— Proximity sensor loop

—Main board
—CapSense trackpad

— CapSense buttons

—Flex PCB

m PSoC 4 S-Series Pioneer Board (main board):

The PSoC 4 S-Series Pioneer board contains PSoC 4000S, KitProg2 circuit, rechargeable battery,
EZ-BLE PRoC Module, F-RAM, switches, LEDs and voltage regulator.

m CapSense Flex PCB:

The Flex PCB has CapSense sensors including buttons, trackpad and proximity. The Flex PCB has

two capacitive sensing buttons, a trackpad with seven row seven column, and a proximity sensor
loop which is used for CapSense proximity sensing.
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Figure 3-4 and Figure 3-5 shows the markup of the

Kit Operation

PSoC 4 S-Series Pioneer board.

Figure 3-4. PSoC 4 S-Series Pioneer Board (Top View)
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1. KitProg2 USB Micro-B connector (J6) 14. RGB LED (LEDS)
2. KitProg2 status LEDs (LED1, LED2 and LED3) 15. KitProg2 user button (SW3)
3. External power supply header (J7) 16. Rechargeable battery (ML2430-HS1, V2)
4. KitProg2 (PSoC 5LP) I/O header (18) 17. User Button (SW2)
5. Power LED (LED4) 18. Reset button (SW1)
6. System power (VDD) selection switch (SW6) 19. Arduino ICSP compatible header (112)
7. KitProg2 custom application/programming header (J)11) ~ 20. EZBLE™ PRoC™ Module (CYBLE-022001-00, U3)
8. Voltage regulator circuit 21. Potentiometer (R2)
9. PSoC 4000S 10-pin program and debug header (J)13) ~ 22. VDD source selection switch (SW4)
10. Arduino™ compatible power and 1/O headers 23. Current measurement selection switch (SW7)
01,12, J3 and J4) 24. PSoC 4000 (U1)
11. 32.768 kHz crystal oscillator (Y1) 25. Programming target (PSoC 4000S/EZ-BLE PRoC) module
12. Voltage Level Translator for F-RAM (U14) selection switch (SW5)
13. Cypress FRAM 1Mb (FM24V10.G, UT1) 26. KitProg2 (PSoC 5LP) programmer and debugger (U15)
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Figure 3-5. PSoC 4 S-Series Pioneer Board (Bottom View)
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27. Flex connector

The PSoC 4 S-Series Pioneer board has the following peripherals:

1.

KitProg2 USB Micro-B connector (J6): The USB cable provided along with the PSoC 4 S-
Series Pioneer Kit connects between this USB connector and the PC.

KitProg2 Status LEDs: Red, amber, and green LEDs (LED1, LED2, and LED3) indicate the sta-
tus of the KitProg2. For details on the KitProg2 status, refer to the KitProg2 User Guide.

External power supply (VIN) header (J7): This header connects the external power supply
input to the onboard regulator. The voltage input from the external supply can be between 6 V
and 12 V.

KitProg2 1/0 header (J8): This header brings out a few GPIOs of the onboard PSoC 5LP. This
includes the USB-12C bridge and USB-UART bridge lines. The additional PSoC 5LP pins are
direct connections to the internal programmable analog logic of PSoC 5LP. You can also use
these pins for custom applications. For more details on the KitProg2, refer to the KitProg2 User
Guide.

Power LED (LED4): The Amber power LED turns on when the kit is connected to a power
source.

System power (VDD) selection switch (SW6): This switch selects the kit operating voltage. It
can select between 1.9V, 3.3V and 5 V.

KitProg2 custom application/programming header (J11): This header brings out more GPIOs
of the PSoC 5LP. It also contains a 5-pin SWD programming header for PSoC 5LP.

Voltage regulator circuit: The kit can operate at four voltage levels, 1.9V, 3.3V, 5V from USB
or external power supply and 3 V from the rechargeable battery. The kit has an onboard 2-chan-
nel regulator from Cypress that provides 3.3 V on one channel and 1.9 V on the other. 3 V is
derived from the onboard battery and 5 V from the USB.

PSoC 4000S 10-pin program and debug header (J13): This 10-pin header allows you to pro-
gram and debug the PSoC 4000S using an external programmer such as MiniProg3. This header
is not populated by default.
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10.Arduino-compatible power and I/O headers: This kit is compatible and operates flawlessly with
third-party Arduino shields. The Arduino-compatible power header (J1) powers Arduino shields.
This header also has provision to power the kit though the VIN input pin. The Arduino-compatible
I/O headers (J1, J2, J3 and J4) bring out the pins from PSoC 4000S to interface with the Arduino
shields.

11.32.768 kHz crystal oscillator (Y1): This kit has a 32.768 kHz crystal oscillator to provide an
accurate low-frequency clock for the PSoC 4000S.

12.Voltage Level Translator for F-RAM (U14): The F-RAM operates at 3.3 V, while the PSoC
4000S can operate at 1.9V, 3.3V, 5V or 3 V. This bidirectional level translator translates the 12C
signals between the F-RAM and the PSoC 4000S.

13.Cypress F-RAM (U11): This kit features a Cypress F-RAM device (FM24V10-G) of 1 Mb capac-
ity. The F-RAM is connected to the 12C interface of the PSoC 4000S. The F-RAM device can be
used similar to an external EEPROM memory for data logging operations. Refer to Using the
FM24V10 F-RAM chapter on page 44 for details on using the F-RAM.

14.RGB LED (LED5): The onboard RGB LED can be controlled from the PSoC 4S00S.

15.KitProg2 user button (SW3): This button is used to switch between the KitPorg2 modes. You
can also use this button to provide input to the PSoC 5LP in custom applications. Note that the
switch connects the PSoC 5LP pin to ground when pressed. Refer to the KitProg2 User Guide for
more details.

16.Rechargeable battery (V2): This kit features an onboard rechargeable battery (ML2430-HS1) to
power the kit at 3 V.

17.User Button (SW2): This button can be used to provide input to the PSoC 4000S. Note that the
switch connects the PSoC 4000S pin to ground when pressed, so you need to configure the
PSoC 40008 pin as resistive pull-up for detecting the switch press.

18.Reset button (SW1): This button is used to reset the PSoC 4000S and the EZ-BLE PRoC Mod-
ule.

19. Arduino ICSP compatible header (J12): This kit features Arduino ICSP compatible header for
SPl interface.

20.EZ-BLE PRoC Module (U3): The kit includes a Cypress EZ-BLE PRoC Module which can be
used for custom applications.

21.Potentiometer (R2): This kit features a potentiometer which connects to an ADC input pin of the
PSoC 40008S.

22.VDD source selection switch (SW4): This switch selects the power source for the kit, either
USB connector/external power supply or battery.

23.Current measurement selection switch (SW7): This switch is used to measure the PSoC
40008 current consumption by turning off all the switches of SW7 and connecting an ammeter
between VDD and P4.VDD test points. Refer to the Current Measurement Switch chapter on
page 39 for more details on how to measure the current.

24 .PSoC 4000S (U1): This kit is designed to highlight the features of the PSoC 4000S device
(CY8C4045AZI-S413).

25.Programming target selection switch (SW5): This switch selects the SWD lines between
PSoC 4000S or EZ-BLE PRoC Module for programming and debugging.

26.KitProg2 (PSoC 5LP) programmer and debugger (U15): The PSoC 5LP device
(CYBC5868LTI-LP039) serving as KitProg2, is a multi-functional system, which includes a pro-
grammer, debugger, USB-12C bridge, and a USB-UART bridge. Refer to the KitProg2 User Guide
for more details.

27.FPC connector (J10): This connects the Flex PCB to the main board.

See Hardware Functional Description chapter on page 36 for details on various hardware blocks.
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3.1.1 How to open the Kit Case
The kit comes with a case that houses an FR4 board called the PSoC 4 S-Series Pioneer board
(main board) and a Flex PCB. The following steps show how to open the case.

1. Pull out the bottom casing by inserting the finger or a sharp edge object (e.g. a plectrum) in the
notch provided, as shown in Figure 3-6.
Note: Do not use your nails to remove the kit case.

Figure 3-6. Opening the bottom case

2. Remove the bottom case by gradually moving the finger along the edge of bottom case, as
shown in Figure 3-7.

Figure 3-7. Removing the bottom case
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3. Hold the kit as shown in Figure 3-8 and pull the bottom side of the casing wall outwards. Hold the
USB connector and lift the board gently.

Figure 3-8. Pull out the main board from the case
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Note that the main board need to be removed slowly because it is connected to the Flex PCB. Flex
PCB is permanently attached to the top case. Do not attempt to separate the Flex PCB from the top
case. Instead, disconnect the Flex PCB from the main board by releasing the FPC connector, J10
(see Figure 3-9). The main board can be used for developing your own applications. Arduino shields
can be plugged into the main board using press-fit connectors provided with the kit.

3.1.2 Disconnecting Flex PCB from main board

The FPC connector, J10, is used to connect Flex PCB to the main board. To disconnect the Flex
PCB from the main board, flip up the latches of the FPC connector and pull out the Flex PCB.
Figure 3-9 below show the sequence of steps to be followed.

Figure 3-9. Disconnecting flex PCB from main board
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3.1.3 Reassembling Kit Case

1.

o ks wbN

6.
7.

Connect the flex PCB to the main board.

Flip the main board and gently push the flex PCB under the main board.

Align the main board switches with respective slots on the top case.

Push the main board switches into the slots gently.

At the other end of the main board, gently press the board until you hear the click sound.
Note: Make sure the onboard components or switch positions are not changed.

Hold the bottom case, align it to the potentiometer and Power Selection switch.

Press on all corners to close the bottom case.

3.1.4 Removing the Overlay

The kit case comes with an attached Overlay that is imprinted with a CIE 1931 color gamut. This
Overlay is intended to be used with CE211584 Trackpad With Color Gamut code example which is pre-
programmed into the PSoC 4 S-Series Pioneer Kit. You can remove this Overlay if you are intend to
use the trackpad without an Overlay. Following steps show how to remove the Overlay.

1.

Hold the kit firmly and pull out the Overlay from the corner, as shown in Figure 3-10. Use a sharp
edge object (e.g. a plectrum or a credit card) to pull the overlay from the corner.
Note: Do not use your nails to remove the Overlay.

Figure 3-10. Removing the Overlay

2.

Slowly lift the Overlay off the case.

After removing the Overlay, keep it in a dust-free place for durability of the micro-suction tape.
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3.1.5 Attaching the Overlay
The Overlay has micro-suction tape on the bottom side that allows you to attach the Overlay to the

kit, when required. Following steps show how to attach the Overlay:

1. Keep the kit on a flat surface. Align the top-left corner of the Overlay to the outline provided on
the case, as shown in Figure 3-11.

Figure 3-11. Attaching the Overlay

KT

CYSCKIT-041-40XX
8 PSoC 4 S-SERIES PIONEER

2. Place the top edge of the Overlay first and then slide your finger along the Overlay surface.

3.2 KitProg2

The PSoC 4 S-Series Pioneer Kit can be programmed and debugged using the onboard KitProg2.
The KitProg2 is a multi-functional system, which includes a programmer, debugger, USB-I12C bridge,
and a USB-UART bridge. The PSoC 4 S-Series Pioneer Kit also supports Mass Storage Program-
ming using KitProg2. A Cypress PSoC 5LP device is used to implement KitProg2 functionality. The
KitProg2 is integrated in most PSoC development kits. For more details on the KitProg2 functionality,

refer to the KitProg2 User Guide available in the following path in kit installation directory:
<Install Directory>\CY8CKIT-041-40XX PSoC 4 S-Series Pioneer Kit\<ver-
sion>\Documentation\KitProg2 User Guide.pdf

Before programming the device, ensure that PSoC Creator and PSoC Programmer software are
installed on the computer. See the Install Software chapter on page 17 for more information.
3.2.1 Programming and Debugging using PSoC Creator

Ensure switch SW5 is in the “PSoC 4000S” position to select the PSoC 4000S as the target device

for programming. In the other position, the EZ-BLE PRoC Module on the kit can be programmed
(see Programming the EZ-BLE PRoC Module chapter on page 30).

1. Connect the PSoC 4 S-Series Pioneer Kit to the PC using the USB cable, as shown in

Figure 3-12. The kit enumerates as a composite device if you are connecting it to your PC for the
first time. The successful enumeration is indicated by the following status LEDs: Amber LED On,
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Green LED Off and Red LED Off. If you do not see the desired LED status, refer to the KitProg2
User Guide for details on the KitProg2 status and troubleshooting instructions.

Figure 3-12. Connect USB Cable to USB connector on the kit

CY8CKIT-041-4
PSoC 4 S-SERIES PIO|

2. Open the desired project in PSoC Creator by selecting File > Open > Project/Workspace. This
provides the option to browse and open your saved project.

3. Select Build > Build Project or pressing [Shift] [F6] to build the project.

4. If there are no errors during build, select Debug > Program or press [Ctrl] [F5]. This programs
the device on the PSoC 4 S-Series Pioneer Kit.

The PSoC Creator has an integrated debugger. You can start the debugger by selecting Debug >
Debug or by pressing [F5]. Refer to the Debugging Using PSoC Creator section in the KitProg2
User Guide for a detailed explanation on how to debug using PSoC Creator.

Programming using PSoC Programmer

PSoC Programmer (3.25 or later) can be used to program existing .hex files into the PSoC 4 S-
Series Pioneer Kit. Refer to the Programming Using PSoC Programmer section in the KitProg2
User Guide for a detailed explanation on how to program using PSoC Programmer.

The KitProg2 firmware normally does not require any update. If necessary, you can use the PSoC
Programmer software to update the KitProg2 firmware. Refer the Updating the KitProg2 Firmware
section in the KitProg2 User Guide for a detailed explanation on how to update the KitProg2 firm-
ware.

Programming the EZ-BLE PRoC Module

For programming the EZ-BLE PRoC Module, follow the instructions provided in Programming and
Debugging using PSoC Creator chapter on page 29. The only exception is to set the switch SW5 to
the “EZ-BLE” position to select the EZ-BLE PRoC Module as the target device for programming.
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3.24 Mass Storage Programmer

The KitProg2 in the PSoC 4 S-Series Pioneer Kit supports programming through a USB Mass Stor-
age interface. This interface allows you to program the PSoC 4000S by copying .hex files into an
emulated USB Mass Storage device. For more details on KitProg2 Mass Storage Programmer, refer
to the KitProg2 User Guide.

3.2.5 USB-UART Bridge

The KitProg2 on the PSoC 4 S-Series Pioneer Kit can act as a USB-UART bridge. The UART lines
between the PSoC 4000S and the KitProg2 are hard-wired on the board, with UART_RX assigned to
PO[4] and UART_TX assigned to PO[5] on PSoC 4000S. For more details on the KitProg2 USB-
UART functionality, refer to the KitProg2 User Guide.

Figure 3-13. UART connection between KitProg2 and PSoC4000S

UART
KitProg2 PSoC 40005
UART TX RX
P12[6] = »{POJ4]
UART R
P12[7] [« X X pops)

3.2.6 USB-I12C Bridge

The KitProg2 can function as a USB-I2C bridge and communicate with the Bridge Control Panel
(BCP) software. The 12C lines on PSoC 4000S device are P3[1] (SDA) and P3[0] (SCL), which are
hard-wired on the board to the 12C lines of the KitProg2. The USB-I2C supports 12C speeds of
50 kHz, 100 kHz, 400 kHz, and 1 MHz. For more details on the KitProg2 USB-12C functionality, refer
to the KitProg2 User Guide.

Figure 3-14. 12C connection between KitProg2 and PSoC4000S

KitProg2 12C PSoC 40005
P12[0] SCL > P3[0]
P12[1]|« SDA »P3[1]
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The PSoC 4 S-Series Pioneer Kit includes five code examples. To access the code examples, dow
load and install the PSoC 4 S-Series Pioneer Kit setup file from www.cypress.com/CY8CKIT-04

n-
1.

After installation, the code examples will be available from Examples and Kits > Kits under PSoC

Creator Start Page.

For more code examples, visit the PSoC 3, PSoC 4, and PSoC 5 code examples page, which lists all

PSoC Creator code examples available across application notes, kits, and PSoC Creator.

4.1 Using the Kit Code Examples

Follow these steps to open and use the code examples.

1. Launch PSoC Creator from Start > All Programs > Cypress > PSoC Creator <version> >
PSoC Creator <version>.

2. On the Start Page, click CY8CKIT-041-40XX under Examples and Kits > Kits. A list of code
examples appears, as shown in Figure 4-1.

3. Click on the desired code example, select a location to save the project and click OK.
Figure 4-1. Open Code Example from PSoC Creator
* X | 7 Start Page

PSoC® Creator™

Getting Started
PSoC Creator Start Page
Quick Start Guide
Intra to PSaC
Intro to PSaC Creator
PSaC Creator Training
Design Tutorials
Getting Started with PSoC 3
Getting Started with PSoC 4
Getting Started with PSoC 5LP
Getting Started with PSoC 4 BLE
Getting Started with PRoC BLE

.

Examples and Kits
Find Code Example ..
o Kits
= CYBCKIT-041-400C¢
] CE210486 USB-HID Trackpad.cywrk
] CE210487 ADC with Breathing LED.cywric
E] CE210488 LP CapSense Buttons cywric
Ef] CE210483 Proximity Sensing.cywrk
E] CE211584 Trackpad With Color Gamut .cywrk
1+ LTaLRIT-08 -3 TAA

Product Information

4. Build the code example by choosing Build > Build <Project Name>. After the build process is
successful, a .hex file is generated.
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5. Connect PSoC 4 S-Series Pioneer Kit to the PC using the USB cable, as shown in Figure 3-12, to
program the kit with the code example.

Choose Debug > Program in PSoC Creator.
If the device is already acquired, programming will complete automatically — the result will appear

in the PSoC Creator status bar at the bottom left side of the screen. If the device is yet to be
acquired, the Select Debug Target window will appear. Select KitProg2/<serial_number> and
click the Port Acquire button, as shown in Figure 4-2.

Figure 4-2. Port Acquire

Select Debug Target

8 T KitProg2/0414036303105400
@ PSoC 40005 CYECA045A71-5413

7 sl
Kit Prog2,/0414038303105400

POWER =3
VOLTAGE_ADC = 3433
FREQUENCY = 2000000
PROTOCOL = SWD

KitProg2 Version 1.01 [HW Rev (x01]

Show all targets

Port Acquire

vl[

Port Setting I

8. After the device is acquired, it is shown in a tree structure below the KitProg2/<serial_number>.
Click the Connect button and then OK to exit the window and start programming, as shown in

Figure 4-3.

Figure 4-3. Connect Device from PSoC Creator and Program

Select Debug Target
B3 KitProg2/041403B303105400

¥ PSoC 40005 CYBC4045A71-5413

Show all targets

[ mesnl
P5cC 40005 CYBCA045AZ1-5413

PSoC 40005 (ARM CMO+)
Silicon |D: (<0BC11477
Cypress 1D: (15011145
Revision: PRODUCTION

Target unacquired

I Connect I

9. After programming is successful, the code example is ready to use.
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Code Examples

Table 4-1 shows a list of code examples that can be used with this kit.
Table 4-1. Code Examples in PSoC Creator

Breathing LED

# Project Title/Description
This code example demonstrates the use of the CapSense_ADC
component to measure an input voltage on an I/O pin. The example also
shows how to implement a breathing LED using the Smart 10
CE210487 ADC with component. The breathing LED effect is implemented by XORing two

PWM signals which have slightly different frequencies. There are four
levels of breathing rate and three different color LEDs used. Depending
on the ADC result, a specific LED and breathing rate is chosen. In
addition to controlling the LEDs, the ADC result is sent over 12C to a host
PC running Cypress's Bridge Control Panel (BCP) software.

CE210488 LP
CapSense Buttons

This code example implements two CapSense buttons using the
CYB8CKIT-041-40XX. The left button is used to control the onboard RGB
LED color and the right button is used to control the brightness of the
RGB LED. Using the low power modes available in the PSoC 4 S-Series
device, an average current of 5 pA per button is achieved when the
touch is not detected.

CE210489 Proximity
Sensing

This code example demonstrates CapSense based proximity sensing
using a PCB trace as a proximity sensor. A Proximity-sensing distance of
5 cm is achieved using a rectangular loop sensor with a 9 cm diagonal.
The proximity detection is indicated by controlling the brightness of an
LED. The LED has a minimum brightness when the hand is at a distance
of 5 cm and gradually increases as the hand approaches the sensor.
Using the low power modes available in the PSoC 4 S-Series device, an
average current of 25 uA is achieved while detecting the proximity of a
hand at 5 cm.

CE211584 Trackpad
With Color Gamut

This code example implements a CapSense based trackpad as a user
interface. The trackpad has the CIE 1931 color gamut imprinted; user
inputs (touch coordinates) are converted to the corresponding color
coordinates. The RGB LED on the board is used to illustrate the chosen
color by modulating the associated signal densities. The brightness of
the RGB LED is controlled by using the two CapSense buttons.

CE210486 USB-HID
Trackpad

This code example implements a CapSense trackpad and two button
sensors using a PSoC 4000S device. The PSoC device is interfaced to a
Windows PC as a mouse using the USB HID protocol. The trackpad con-
trols the cursor on the PC and the two button sensors act as right-click
and left-click buttons. To optimize device power consumption and pro-
vide optimum touch response, this code example implements two power
modes: Fast Scan Mode and Slow Scan Mode.

All code examples have an associated PDF document containing the project details, which can be
accessed from the PSoC Creator as shown in the Figure 4-4. Please refer to the respective code
example document for more details on the functionality and implementation.
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Figure 4-4. Code Example Document in PSoC Creator
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A1 Schematics

Refer to the schematics files available in the kit installation directory under following paths:

m <Install Directory>\CY8CKIT-041-40XX PSoC 4 S-Series Pioneer Kit\<ver-
sion>\Hardware\CY8CKIT-041-40XX Schematic.pdf

m <Install Directory>\CY8CKIT-041-40XX PSoC 4 S-Series Pioneer Kit\<ver-
sion>\Hardware\CY8CKIT-041-40XX Flex Schematic.pdf

A.2 Hardware Functional Description

This section provides detailed explanation on individual hardware blocks of the PSoC 4 S-Series
Pioneer Kit.

A21  PSoC 4000S (U1)

This kit features a PSoC 4000S (CY8C4045AZI-S413) family device. PSoC 4000S is a scalable and
reconfigurable platform architecture for a family of programmable embedded system controllers with
an ARM Cortex-M0+ CPU. The PSoC 4000S device family, based on this platform architecture, is a
combination of a microcontroller with Programmable Analog Blocks, Programmable Digital Blocks,
Programmable Interconnect and Routing, CapSense, standard communication and timing peripher-
als.

For more information, refer to the PSoC 4000S web page and the PSoC 4000S Family Datasheet.

A22  PSoC 5LP (U15)

An onboard PSoC 5LP (CY8C5868LTI-LP039) is used as KitProg2 to program and debug PSoC
4000S. The PSoC 5LP connects to the USB port of a PC through a USB connector and to the SWD
and other communication interfaces of the PSoC 4000S device. The PSoC 5LP is a true system-
level solution providing MCU, memory, analog and digital peripheral functions in a single chip. The
CY8C58LPxx family offers a modern method of signal acquisition, signal processing, and control
with high accuracy, high bandwidth, and high flexibility. Analog capability spans the range from ther-
mocouples (near DC voltages) to ultrasonic signals.

For more information, visit the PSoC 5LP web page. Also, refer to the CY8C58LPxx Family Data-
sheet.

A2.3 Serial Interconnection between PSoC 5LP and PSoC 4000S

In addition to use as an onboard programmer, the PSoC 5LP is used as a USB-Serial interface for
the USB-UART bridge and USB-I2C bridge, as shown in Figure A-1. The I12C bus contains firmware-
controlled resistive pull-ups using FETs, which can be enabled or disabled using the PSoC 5LP pins.
The USB-Serial pins of the PSoC 5LP are also connected to the I2C/UART pins of the PSoC 4000S
that are available on the Arduino-compatible I/O headers; therefore, the PSoC 5LP can be used to
control Arduino shields with an SPI/I2C/UART interface.
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Note: The KitProg2 does not support USB-SPI bridge functionality. The SPI pins of the PSoC 4000S
are connected to the PSoC 5LP for enabling SPI communication between PSoC 5LP and PSoC
4000S for custom PSoC 5LP applications.

Figure A-1. Schematics of Serial Interface Connections and 12C Pull-Up via FETs
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Power Supply System

The power supply system on this board is versatile, allowing the input supply to come from the fol-
lowing sources:

m 5-V power from onboard USB connector
m 6-V to 12-V power from Arduino shield or from external power supply through VIN header (J7)
m 3-V from battery

The PSoC 4 S-Series Pioneer Kit is designed to support 1.9 V, 3.3 V or 5 V operation for PSoC
4000S and EZ-BLE PRoC Module, when powered from USB port or external power supply. The volt-
age selection is made through the switch SW6. The voltage regulator (MB39C011A) from Cypress
has two channels and generates a constant 3.3 V on one channel, and 1.9 V on the other. The
onboard rechargeable battery provides 3 V to the kit. The selection between battery and USB is
made through the VDD source selection switch, SW4. When the kit is powered from the USB con-
nector, it provides 3.3 V and 5 V to the Arduino-compatible power header. Figure A-2 shows the
schematics of the voltage regulator and power selection circuit.
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Figure A-2. Schematics of Voltage Regulator Circuit and Power Selection Switch
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7.5K 5% 22 uF
0.1 uF
= = = c42 R61 - N Iﬁ L
1nF 820 ohm 5% B B
R56 R60
20K1%  2.32K1%
VBUS
D1 F2 VGG vovss Lo V33
VIN MBRO520L 1 2
D5 2ERO Voltage Regulator
PTC Resettable Fuse
MBRO520L
swe VAR_VDD
ow VDD
4
VO_V1.91 5 VO_Vi.9
1 % 4 VBAT
VO V33 VO V3.3 1
ey . 2 o 60 POS1 D7,
VAR_VDD VAR_VDD 212
o [ 053 pos2 PMEG20TOAEB, 115
X s, | 7 V5.0 Legl3
4 — —. |8
4 8 SPDT
DP3T
SWITCH (SW6) SETTINGS SWITCH(SW4) SETTINGS
SWé Voltage sSwW4
Power Suppl
POSITION POSITION PPy
POS1 1.9v POS1 VREG/VBUS
POS2 3.3V
POS2 VBAT
POS3 5.0v
Power Supply Selection

m PSoC pins should not be connected to overvoltage/reverse voltage more than what is mentioned

in the datasheet

m PSoC pins should not be driven with currents more than what is mentioned in the datasheet.

Battery Charging Circui

t

The 3.3 V generated by the regulator is also used to charge the battery as shown in Figure A-3. Note
that the battery charging time is not optimal if the battery is discharged below 2.2 V (dead threshold).
Please refer to the battery datasheet for details.
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Figure A-3. Battery Charging Circuit

DB2J31400L 75 ohm

ML2430-HS1
3
CR2032
3
3
<
=

3V Coin-cell Battery

Note: Please consider the polarity marks provided on the board while re-soldering the battery.

Protection Circuits

The power supply rail has reverse-voltage, overvoltage, short circuit, and excess current protection
features, as shown in Figure A-4. A PTC resettable fuse is connected to protect the computer's USB
port from shorts and over current. ORing diodes prevent damage to components when the board is
powered from different voltage sources at the same time. The ESD protection is provided for the

USB connector.
Figure A-4. Power Supply Block Diagram with Protection Circuits
‘ 1/O Header

5\i Vin 3.3v

pPTC

Coin-cell
Battery |  curren

Battery
Charging

o |vBUS Regulator %
g 3.3V ) |:
PTC 5V % >

4

S
Pr&ie(lz:l)ion PSoC 5LP

PSoC 4000S 10
Pin Prog. Header

Current Measurement Switch

To measure the PSoC 4000S power consumption, the switch SW7 is populated in series with the
power supply to the PSoC 4000S which can be used to measure current using an ammeter without
the need to remove any components from the board. The KitProg2 on the board is also able to mea-
sure the power consumption of PSoC 4000S using its internal Del-Sig ADC and SAR ADC. For this
purpose, either a 0.86 Q shunt resistor or 9.76 Q shunt resistor can be selected using the switch
SW7. Note that the contact resistance of the switch is 150 mQ. The effective shunt resistance

achieved will be 1.01 Q and 9.91 Q respectively.
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Figure A-5. Schematics of Current Measurement Switch

N (]
VDD VTARG g & & 8§
P2 B ® B B
_ReD R20 oo o
{_NO LOAD Q R Q R
ZERO sw7 l ‘
1 10
T2 VDD 1——51 10
. T LA P
16 P4_VDD
Pwa R = B
0.860hm R8
4yt 7 L Trgﬁ
9.76 Ohm R4
5 55 5 |-L
ZERO NO LOAD
5 POLE DIP SW
SWITCH(S7) SETTINGS
Load Pl |P2 | P3 |P4 | P5
Default |oep|ord OFF|OFF| ON Note: To avoid leakagg
(short) during battery operation
remove R20
1 ohm ON |ON | ON |OFF|OFF
10 ohm |py |ON |OFF [ON |OFF

By default P5 is ON.

To enable PSoC S5LP Power Monitoring, Pl and P2 should be ON,
P5 should be OFF and the corresponding resistor (1 ohm/ 10 ohm)
should be connected (P3/P4).

To enable external power monitoring, Ammeter should be
connected to TPl and TP2. P1, P2...P5 should be OFF.

Power Monitoring

The following methods are supported for measuring the current consumption of the PSoC 4000S

device.
m Measurement using ammeter when powered from USB connector or battery

When the board is powered through the USB connector or battery, turn off all the switches of SW7
and connect an ammeter between P4.VDD and VDD test points, as shown in Figure A-6.

Figure A-6. Current Measurement when Powered from USB Connector or Battery

Note: While measuring the current consumption of PSoC 4000S device, remove R118 from the
board in order to get accurate current measurement values.
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Figure A-7. Potentiometer Schematics
P4_VDD

R118
3 R2 10K1
ZERO

R133 o
C79 1L

Y ZERO torll
R125
J2_P2_4 L& L

ZERO . =
NO LOAD Potentiometer

Remove R118, while performing
low power measurement.

Note that there is a current leakage of 80 yA on VTARG node into the PSoC 5LP when using battery
(VBAT) as the power supply. Remove the resistor R20 to avoid the leakage and to get accurate cur-
rent measurement values. You will not be able to program the PSoC 4000S while you have removed
resistor. So it is recommended to populate the resistor R20 back once the measurement is done to
enable programming of PSoC 4000S. After measuring the current consumption, move switch P5 of
SW?7 to ON position for normal operation of the kit. See Figure A-5 on page 40 for other switch com-
binations of SW7.

m Measurement using ammeter when powered from an external power supply

When the PSoC 4 S-Series Pioneer Kit is powered from an external power supply, remove the USB
cable from J6. Connect the positive terminal of the external power supply to the positive terminal of
the ammeter and the negative terminal of the ammeter to the P4.VDD test point. Connect the nega-
tive terminal of the external power supply to any GND pin on the board. Figure A-8 shows the
required connections.

Figure A-8. Current Measurement when Powered Externally

VOLTAGE SOURCE

Expansion Connectors

Arduino-compatible Headers (J1, J2, J3, J4, and J12)

This kit has five Arduino-compatible headers: J1, J2, J3, J4, and J12. You can develop applications
based on the Arduino shield’s hardware.

The J1 header contains 1/0O pins for reset, internal reference voltage (IOREF), and power supply
lines. The J2 header is an analog port that contains I/O pins for the SAR ADC. The J3 header is pri-
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marily a digital port that contains I/O pins for PWM, 12C, SPI, and analog reference. The J4 header is
also a digital port that contains 1/0 pins for UART and PWM. The J12 header is an Arduino ICSP
compatible header for the SPI interface and is not populated. Most of the pins available on J2, J3
and J4 headers have multiplexed functionalities such as CapSense sensors, user switch or RGB
LEDs. Refer to Onboard Peripherals chapter on page 51 for details about onboard peripheral con-
nections to the pins on these headers.

Note: Pin P1[7] has a provision to connect a 1.0 uF capacitor (C87) as a bypass capacitor for SAR
ADC operation. This capacitor is not applicable for the PSoC 4000S device and is provided only for
footprint compatibility with CY8CKIT-041-41XX.

Additional Functionality of Header J2

The J2 is a 8x2 header that supports Arduino shields. On the non-Arduino side of the header (even
pins - Pin 2, 4, 6, and so on), some pins from port 0, port 1, port 3 and port 4 pins of PSoC 4000S are
brought for general-purpose use.

Functionality of Unpopulated Header J12

The J12 is a 3x2 header that supports Arduino shields. This header is used on a small subset of
shields and is not populated on the PSoC 4 S-Series Pioneer Kit.

PSoC 5LP GPIO Header (J8)

The J8 is a 8x2 header provided on the kit to bring out several pins of the PSoC 5LP to support
advanced features such as a low-speed oscilloscope and a low-speed digital logic analyzer. This
header also contains the USB-UART bridge pins and USB-I2C bridge pins that can be used when
these pins are not accessible on the Arduino headers because a shield is connected. The additional
PSoC 5LP pins are direct connections to the internal programmable analog logic of PSoC 5LP. This
header also has GPIOs for custom application usage.

KitProg2 Custom Application Header (J11)

A 5x2 header is provided on the board to bring out more GPIOs of PSoC 5LP for custom application
usage. This header also brings out the PSoC 5LP programming pins and can be programmed using
MiniProg3 and 5-pin programming connector.

USB Micro-B Connector

The PSoC 5LP connects to the USB port of a PC through a USB Micro-B connector, which can also
be used to power the PSoC 4 S-Series Pioneer Kit. A resettable polyfuse is used to protect the com-
puter's USB port from shorts and over current. If more than 500 mA is drawn from the USB Micro-B
connector, the fuse will automatically break the connection until the short or overload is removed.

CapSense Circuit

The CapSense sensors such as trackpad, buttons and proximity sensors are on Flex PCB whereas
CapSense components such as 560 Q series resistors on sensor lines, CMOD and CTANK capaci-
tors which are essential for CapSense with Self-Capacitance functionality, CintA and CintB capaci-
tors which are essential for CapSense with Mutual-Capacitance functionality are on the main board.
A 2.2-nF capacitor is present on the CMOD pin, P4[1], for CapSense operation. This kit also sup-
ports CapSense designs that enable waterproofing. On this kit, the hatch (Shield pattern) can be
connected to the Shield pin, P3[5] or to ground by a three-pad 0Q resistor (R75 and R76). By default,
R75 is mounted on the kit, which connects the hatch to the Shield pin. This is required for liquid toler-
ance.
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For details on using CapSense, design guidelines and capacitive sensing, refer to AN85951 - PSoC
4 CapSense Design Guide.

CapSense Trackpad
The Flex PCB has a 14 element capacitive trackpad, which is connected to the PSoC 4000S pins.
This trackpad controls the LED color in CE211584 Trackpad With Color Gamut code example.

CapSense Proximity Sensor

The Flex PCB has one proximity sensor loop, which is connected to pin P1[6]. The proximity senor
loop in the PSoC 4 S-Series Pioneer Kit can also be used as a Guard sensor to make the sensors
tolerant to streams of liquids.

This proximity sensor controls the LED brightness in CE210489 Proximity Sensing code example.

CapSense Buttons

The Flex PCB has two buttons, the left button (BTN1) is connected to pin PO[1] and the right button
(BTNZ2) is connected to pin P0O[2].

These buttons control the LED brightness in CE211584 Trackpad With Color Gamut code example.

LEDs

The PSoC 4 S-Series Pioneer Kit has five LEDs. Three status LEDs (Red, Amber and Green) indi-
cate the status of the KitProg2. An amber LED indicates the status of power supplied to the kit. The
kit also has a general-purpose RGB LED connected to PSoC 4000S for user applications.

Push Buttons

The PSoC 4 S-Series Pioneer Kit has a reset button (SW1) and two user buttons. The reset button is
connected to the XRES pin of the PSoC 4000S and EZ-BLE PRoC Module, and is used to reset both
the devices. One user button (SW2) is connected to PO [7] of the PSoC 4000S device. The other
user push button (SW3) is connected to P1 [2] of the PSoC 5LP. All the buttons connect to ground on
activation (active low).

Cypress Ferroelectric RAM (F-RAM)

The PSoC 4 S-Series Pioneer Kit contains an F-RAM device (FM24V10-G) that can be accessed
through 12C lines P3 [0] and P3 [1] of the PSoC 4000S. The F-RAM has a capacity of 1-Mbit (128
KB) with an 12C speed up to 3.4 MHz. The 12C slave address of the F-RAM device is 7 bits wide, and
the two least significant bits are configurable through physical pins. These pins are hard-wired to 00
on the board. By default, the address of the F-RAM device used on the kit is 0x50. This address can
be modified by changing the R68/R71 (A1) and R67/R70 (A2) resistor pairs. The operating voltage
range of the F-RAM is between 2 V and 3.6 V. To prevent the F-RAM from operating at voltages
greater than 3.6 V, the power supply to the F-RAM is derived from the output of the 3.3-V regulator.
The I12C lines are connected to the 3.3 V side of the onboard level translator to allow the F-RAM to
communicate with the PSoC 4000S operating at 5 V. For more information on using the F-RAM,
refer to Using the FM24V10 F-RAM chapter on page 44.

EZ-BLE PRoC module

The PSoC 4 S-Series Pioneer Kit includes an EZ-BLE PRoC Module. The EZ-BLE PRoC Module is
a fully integrated, 10x10x1.8 mm, fully certified, programmable module designed for ease-of-use
and reduced time-to-market. It contains Cypress’s PRoC BLE device, two crystals, chip antenna,
shield, and passive components. For more information on using the EZ-BLE PRoC module, see
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Using EZ-BLE PRoC Module chapter on page 46.

External Crystals

The PSoC 4 S-Series Pioneer Kit includes a 32.768 kHz (Y1) external crystal for the WCO input. The
WCO is used to provide an accurate low-frequency clock to PSoC 4000S for Deep Sleep wake up
intervals, and WDT reset intervals.

Using the FM24V10 F-RAM

The PSoC 4 S-Series Pioneer Kit has an onboard Ferroelectric RAM (F-RAM) chip that can hold up
to 1 Mb of data. The chip provides an I2C communication interface for data access. It is hard-wired
to the 12C interface (P3[0] and P3[1] of the PSoC 4000S); the same lines are routed to the KitProg2
I2C interface. Because the F-RAM device is an 12C slave, it can be accessed or shared among vari-
ous 12C masters on the same lines. For more details on the F-RAM device, refer to the device data-
sheet.

Address Selection

The slave address of the F-RAM device consists of three parts, as shown in Figure A-9: slave ID,
device select, and page select. Slave ID is an F-RAM family-specific ID provided in the datasheet of
the particular F-RAM device. For the device used on the PSoC 4 S-Series Pioneer Kit (FM24V10-G),
the slave ID is 1010b. Device select bits are set using the two physical pins A2 and A1 in the device.
The setting of these two pins in PSoC 4 S-Series Pioneer Kit is controlled by resistors R68/R71 (A1)
and R67/R70 (A2). Because the memory location in F-RAM is divided into two pages of 64 KB each,
the page select bit is used to refer to one of the two pages in which the read or write operations will
take place.

Note: The 8-pin SOIC footprint provided for the F-RAM FM24V10 on the PSoC 4 S-Series Pioneer
Kit is compatible with all 12C-based F-RAM devices from Cypress (FM24Vxx, FM24CLxx, and
CY15BxxxJ parts). The F-RAM parts with more than 64 KB size support only four addresses (four
devices of the same type on the same 12C bus); resistors connected to A1 (R68/R71)) and A2 (R67/
R70) pins can be used to select any of the four addresses. The F-RAM parts with less than 64 KB
and FM24CLxx parts support eight addresses; resistors connected to A0 (R69/R72), A1 (R68/R71))
and A2 (R67/R70) pins can be used to select one of the eight addresses.

Figure A-9. F-RAM I12C Address Byte Structure
MSB LSB

1 0 1 0 A2 | A1 [Al6 |RIW

1III|

/ }
Slave ID—J’\—Device _/ Page
Select select

High Speed Mode (Hs-mode)

The FM24V10 supports a 3.4 MHz high-speed mode. A master code (00001XXXb) must be issued
to place the device into high-speed mode. Communication between master and slave will then be
enabled for speeds up to 3.4 MHz. A STOP condition will exit Hs-mode. Single-byte and multiple-
byte reads and writes are supported.
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Figure A-10. F-RAM I2C Data Format for HS Mode

Data transfer format in Hs-mode

. F/S-mode Hs-mode _F/S-mode
S | MASTER CODE | 1 SLAVE ADD. | RW | 0 DATA A1} P
| I
\— n (bytes+ack.
_Hs—mode continues
Acknowledge or
No Acknowledge No Acknowledge !

Write/Read Operation

The F-RAM device datasheet includes details on how to perform a write/read operation with the F-
RAM. Figure A-11 and Figure A-12 provide a snapshot of the write/read packet structure as a quick

reference.

—
S [SLAVE ADD.

| —

Figure A-11. F-RAM Single-Byte and Multiple-Byte Write Packet Structure

By F-RAM

il

)]

Single-Byte Write
Start Address & Data l Sfp
[ = T T T TTT FT T T TTT FT T T TTT
S| Slave Address ¢ A Address MSB A Address LSB A Data Byte AP
| * T * I B f I B
Acknowledge
Multi-Byte Write
Start
Stop
Address & Data
T T TT0 T T T T TTTT FT T TTT FTT T TTT
S | Slave Address 0| A Address MSB A Address LS| A Data Byte A Data Byte AlP
N T | N N Y I |

Acknowledge
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Figure A-12. F-RAM Single-Byte and Multiple-Byte Read Packet Structure

Current Address Read

C No
By Master Start Address Acknowledae .
i l . Stop

T T TTTT FTT T TT T
S| Slave Address X 1] A Data Byte 1P
T T | T Y

By F-RAM > Acknowledge Data

Sequential Read

No

By Master > Start Address Acknowledge Acknowledge
i l l l I — Stop

FTT T T T T FTTTTTTT FTTTTTT
S| Slave Address X 1[A Data Byte A Data Byte

By F-RAM Acknowledge Data

P

Selective (Random) Read

Start No
l Address Start Address Acknowledge
By Master
! ] ' i 4 Jp———
IFTT T TTT FTTTTTT T T T TTT UL FT T T TTT

s Slave Address X 1| A Data Byte 1P
N N Y I

— 4 4 t ] T
Y Acknowledge DStS

As the figures show, operations start with the slave address followed by the memory address. For
write operations, the bus master sends the slave address and memory address followed by one or
more data bytes. Each byte of data is written to consecutive locations in the memory, and the mem-
ory generates an acknowledgement condition.

For ‘Current Address Read’ and ‘Sequential Read’, the bus master sends only the slave address.
The memory address used is the same address that was set by the previous ‘Write’ or ‘Selective
Read’ operation. For ‘Selective Read’ operations, after receiving the complete slave address and
memory address, the memory will begin shifting data from the current address on the next clock

Note: You can communicate with the F-RAM using the Bridge Control Panel (BCP) software similar
to the way you communicate with any other 12C slave device. Refer to the KitProg2 User Guide for
more details on how to use the BCP to communicate with an 12C slave device. Visit the
CY15FRAMKIT-001 Serial F-RAM Development Kit webpage for code examples and the Arduino
library for interfacing 12C F-RAM devices with the PSoC 4 family. Please note that PSoC 4 S-Series
Pioneer Kit needs to be power cycled when the F-RAM I2C is stuck. F-RAM I2C will be stuck if the
PSoC 4000S device is reset while it is communicating with the F-RAM.

Using EZ-BLE PRoC Module

To get started with the EZ-BLE PRoC module, refer to the application note AN96841 - Getting
Started With EZ-BLE PRoC Module. This application note introduces you to Cypress’s EZ-BLE fam-
ily of Bluetooth Smart modules, helps you explore the EZ-BLE module architecture and development
tools and shows you how to create your first project with the EZ-BLE PRoC Module and PSoC Cre-
ator, the development tool used for all EZ-BLE modules. This application note also guides you to
more resources to accelerate in-depth learning about the Cypress EZ-BLE solutions. Visit
www.cypress.com/ez-bleprocmodule/ for additional information on the EZ-BLE PRoC Module.

The EZ-BLE PRoC module includes the following connections to the PSoC 4000S and KitProg2:
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m [2C connections to KitProg2 and PSoC 4000S. See Table A-1 for details.

m SWD connections to KitProg2 through the switch SW5. The SWD connections are shared
between the PSoC 4000S and EZ-BLE PRoC Module.

The connections between EZ-BLE PRoC Module and PSoC 4000S are shown in Figure A-13
Figure A-13. EZ-BLE PRoC Connections

GNDf1 ;
P41 35— BLE scL
P5.1 [
: 00 P50 [5 BIEVODR =
. CYBLE-022001-00 , /P ['5 5 =
*—557| P4.0
*—7g| P3.6
*—g| P15
P e nfomod R38
~N<wow ~©o w<~o
P S JRp=— e G BLE_SCL OHP30
afoaxX>aoaod®aaaa ZERO
R37
~|ofw|s|m |- [o|o|o|~|©o BLE_SDA
e S KA R =4 = P31
l 8 ZERO
>\
1T}
BLE_XRES)) = = > BLE_SWDCLK PRoC BLE and PSoC 4000S
Connections

L <> BLE_SWDIO
BLE XRES (—B22AANAZERO___((RESET

BLE Reset
VoD BLE_VDD
330 OHM @ 100MHZz
cs BLE_VDDR
:Em:
L 330 OHM @ 100MHz
EZ-BLE PRoC Module
Table A-1. EZ-BLE PRoC Connections
EZ-BLE PRoC Module Connections
EZ-BLE PSoC 4 KitProg2 Description
BLE_SDA, P5.0 P3.1 12C_SDA, P12.1 GPIO/12C_SDA
BLE_SCL, P5.1 P3.0 12C_SCL, P12.0 GPIO/I2C_SCL
BLE_SWDIO, P0.6 - SWDIO, P12.2 SWD /O
BLE_SWDCLK, P0.7 |- SWDCLK, P12.3 SWD Clock

To program the EZ-BLE PRoC Module using KitProg2, follow the instructions provided in Program-

ming the EZ-BLE PRoC Module chapter on page 30.
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A.5 Migrating Projects Across Different Pioneer Series Kits

All Cypress Pioneer series kits are Arduino Uno compatible and have some common onboard
peripherals such as RGB LED, CapSense and User Switch. However, the pin mapping in each of the
boards is different due to differences in pin functions of the PSoC device used. This section lists the
pin mapping of the Pioneer series kits to allow for easy migration of projects across different kits.

In some cases, the pins available on the Pioneer kit headers are a superset of the standard Arduino
Uno pins. For example, J2 contains only one row of pins on the Arduino Uno pin layout while it con-
tains 2 rows of pins on many of the Pioneer series kits.

Figure A-14. Pioneer series kits pin map

Arduino-compatible
1/0 headers

Arduino-compatible
power header

CY8CKIT-042-BLE
6x2 header

CY8CKIT-041-41XX
8x2 header
CY8CKIT-042 & CY8 CKIT-044
9x2 header -

CY8CKIT-048
10x1 header
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A5A1 Arduino Uno Compatible Headers
Table A-2. J1 Arduino Compatible Header Pin Map

Pioneer Series Kits

CY8CKIT-

# Arduino Pin | CY8CKIT- | CYS8CKIT- | CYSCKIT- | CYSCKIT- | CYS8CKIT- | 041-40XX/ | CY8CKIT-
042 040 042-BLE 044 046 CY8CKIT- 048

041-41XX
1 VIN VIN VIN VIN VIN VIN VIN VIN
2 GND GND GND GND GND GND GND GND
3 GND GND GND GND GND GND GND GND
4 5V V5.0 V5.0 V5.0 V5.0 V5.0 V5.0 V5.0
5 3.3V V3.3 V3.3 V3.3 V3.3 V3.3 V3.3 V3.3
6 RESET RESET RESET RESET RESET RESET RESET RESET
7 IOREF P4VvDD | P4VDD | BLE.VDD | P4.VDD | P4LVDD | P4.VDD | PAC.VDD
8 NC NC NC NC NC NC NC NC

Table A-3. J2 Arduino Compatible Header Pin Map
Pioneer Series Kits

CY8CKIT-

# Arduino Pin | CY8CKIT- | CYSCKIT- | CYS8CKIT- | CYSCKIT- | CYSCKIT- | 041-40XX/ | CY8CKIT-
042 040 042-BLE 044 046 CY8CKIT- 048

041-41XX
1 A0 P2[0] PO[0] P3[0] P2[0] P2[0] pP2[0]" P3[0]
2 — Pof2]! — P2[0] P2[6]’ P3[6]' P1[6]" —
3 A1 P2[1] PO[1] P3[1] P2[1] P2[1] p2(1]! P3[1]
4 — Po[3]! — P2[1]! Pe[5]" P3[7]! P4[o]' —
5 A2 P2[2] Po2]" P3[2] P2[2] P2[2] P22]" P3[2]
6 — P4.vDD — P212]" Poe]’ P9[0] P4.vDD —
7 A3 P2[3] PO[4]" P3[3] P2[3] P2[3] P2[3]" P3[3]
8 — P1[5]" — P2[3]" P4[4]' Po[1] Po[1]! —
9 A4 P2[4] P1[3] P3[4] P2[4] P2[4] P2[4]" P34’
10 — P1[4]" — P2[4]" P4[5]" P9[2] Po[6]" —
1 A5 P2[5] P1[2] P3[5] P2[5] P2[5] P2[5] P3[7]"
12 — P1[3]" — p2[5]’! P46’ PI[3] por71’! —
13 — PO[0] — — PO[0] — P2r6]’ P26’
14 — GND — — GND — GND —
15 _ PO[1] — — PO[1] — P3[4’ P2[5]"
16 — P1[2]" — — P3[4]" — P3[6]" —
17 — P1[0] — — PO[7]' — — P2[1]!
18 — P1[1]" — — P3[5]' — — -
19 — — — — — — — P3[5]"
20 — — — — — — — —

Note 1: These pins are also used for onboard peripherals. Refer to the tables in the A.5.2 Onboard Peripherals
section for connection details.
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Table A-4. J3 Arduino Compatible Header Pin Map

Pioneer Series Kits

CYS8CKIT-

# Arduino Pin | CYSCKIT- | CYS8CKIT- | CYSCKIT- | CYSCKIT- | CYSCKIT- | 041-40XX/ | CY8CKIT-
042 040 042-BLE 044 046 CYS8CKIT- 048

041-41XX
1 D8 P2[6] P1[4] PO[5] PO[2] PO[2] Po3]! P2[4]!
2 D9 P3[6] P1[5] PO[4] PO[3] PO[3] P2[7] P1[7]!
3 D10 P3[4] P1[6] PO[2] P2[7] P6[3] Po[o]! PO[7]
4 D11 P3[0] P1[1]! PO[0] P6[0] P6[0] P1[0]! PO[4]
5 D12 P3[1] P3[1] PO[1] P6[1] P6[1] P1[1]! PO[5]
6 D13 PO[6] P1[7] PO[3] P6[2] P6[2] P1[2]! PO[6]
7 GND GND GND GND GND GND GND GND
8 AREF P1[7] NC VREF P1[7] VREF P17 P1[3]"
9 SDA P4[1] P1[3] P3[4] P4[1] P4[1] P3[1] P4[1]
10 SCL P4[0] P1[2] P3[5] P4[0] P4[0] P3[0] P4[0]

Note 1: These pins are also used for onboard peripherals. Refer to the tables in the A.5.2 Onboard

Peripherals section for connection details.

Table A-5. J4 Arduino Compatible Header Pin Map

Pioneer Series Kits
CY8CKIT-

# Arduino Pin | CY8CKIT- | CYSCKIT- | CYSCKIT- | CYSCKIT- | CYSCKIT- | 041-40XX/ | CY8CKIT-

042 040 042-BLE 044 046 CY8CKIT- 048

041-41XX

1 DO PO[4] PO[5] P1[4] P3[0] P3[0] PO[4] PO[4]
2 — — — — — P8[0] — —
3 D1 PO[5] PO[6] P1[5] P3[1] P3[1] PO[5] PO[5]
4 — — — — — P8[1] — —
5 D2 Pof7]! PO[7] P1[6] P1[0] P1[0] P1[4]" P1[5]"
6 — — — — — P8[2] — —
7 D3 P3[7] P32’ P1[7] P1[1] P1[1] P1[3]" P2[3]"
8 — — — — — P8[3] — —
9 D4 PO[0] PO[3] P1[3] P1[2] P1[2] P1 [5]1 P1 [2]1
10 — — — — — P8[4] — —
1 D5 P3[5] P3[0] P1[2] P1[3] P1[3] P3[5]" P1[1]"
12 — — — — — P8[5] — —
13 D6 P1[0] P1[0] P1[1] P5[3] P5[6] P3[7]1 P1 [0]1
14 — — — — — P8[6] — —
15 D7 P2[7]" P2[0]" P1[0] P5[5] P5[5] Po[2]" P2[7]"
16 — — — — — P8[7] — —

Note 1: These pins are also used for onboard peripherals. Refer to the tables in the A.5.2 Onboard

Peripherals section for connection details.
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A5.2 Onboard Peripherals
Table A-6. CapSense Pin Map
Pioneer Series Kits
CYS8CKIT-
# CapSense Pin CY8CKIT- | CYSCKIT- | CY8CKIT- | CYBCKIT- | CYSCKIT- | 041-40XX/ | CY8CKIT-
042 040 042-BLE 044 046 CY8CKIT- 048
041-41XX

1 CapSense Sensor 1 P1[1] — P2[1] P4[4] PO[6] P1[7] —
2 CapSense Sensor 2 P1[2] — P2[2] P4[5] P4[5] P2[0] —
3 CapSense Sensor 3 P1[3] — P2[3] P4[6] P4[4] P2[1] —
4 CapSense Sensor 4 P1[4] — P2[4] P3[4] P4[7] P2[2] —
5 CapSense Sensor 5 P1[5] — P2[5] P3[5] P4[6] P2[3] —
6 CapSense Sensor 6 — — — — P7[4] PO[3] —
7 CapSense Sensor 7 — — — — P7[5] PO[6] —
8 CapSense Sensor 8 — — — — P7[6] PO[0] —
9 CapSense Sensor 9 — — — — P7[7] P1[5] —
10 | CapSense Sensor 10 — — — — POI[0] P1[0] —
11 CapSense Sensor 11 — — — — PO[1] P1[1] —
12 | CapSense Sensor 12 — — — — P7[2] P1[2] —
13 | CapSense Sensor 13 — — — — P7[3] P1[3] —
14 | CapSense Sensor 14 — — — — — P1[4] —
15 | CapSense Sensor 15 — — — — — PO[1] —
16 | CapSense Sensor 16 — — — — — PO[2] —
17 | CapSense Sensor 17 — — — — — P3[7] —
18 CMODO P4[2] PO[4] P4[0] P4[2] P4[2] P4[1] —
19 CTANKO P4[3] PO[2] P4[1] P4[3] P4[3] P4[0] —
20 cmobn1! — — — — P5[0] — —
21 CTANK1' — — — — P5[1] — —
22 CintA? — — — — — P4[2] —
23 CintB? — — — — — P4[3] —
24 CapSense Shield PO[1] — P1[6] PO[1] PO[2] P3[5] —

Note 1: CMOD1, and CTANK1 are available only in the CY8CKIT-046 PSoC 4 L-Series Pioneer Kit.
Note 2: CintA and CintB are available only in the CY8CKIT-041-40XX and CY8CKIT-041-41XX.

Table A-7. Proximity Header Pin Map

Pioneer Series Kits
o CYSCKIT-
# Proximity Pin CY8CKIT- | CYBCKIT- | CY8CKIT- | CY8CKIT- | CY8BCKIT- | 041-40XX/ | CY8CKIT-

042 040 042-BLE 044 046 CY8CKIT- 048

041-41XX
1 — P2[0] P2[0] P3[7] P9[4] P1[6] —

PROXIMITY
2 — — — P3[6] P9[5] — —
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Table A-8. RGB LED Pin Map

Pioneer Series Kits
) CYSCKIT-
# LED Pin CYSCKIT- | CYSCKIT- | CYSCKIT- | CYSCKIT- | CYSCKIT- | 041-40XX/ | CYSCKIT-
042 040 042-BLE 044 046 CYSCKIT- 048
041-41XX
1 Red P1[6] P3[2] P2[6] PO[6] P5[2] P3[4] P1[4]
2 Green PO[2] P1[1] P3[6] P2[6] P5[3] P2[6] P2[6]
3 Blue PO[3] PO[2] P3[7] P6[5] P5[4] P3[6] P1[6]
Table A-9. User Switch Pin Map
Pioneer Series Kits
; ; CYSCKIT-
# Switch Pin CYSCKIT- | CYSCKIT- | CYSCKIT- | CYSCKIT- | CYSCKIT- | 041-40XX/ | CYSCKIT-
042 040 042-BLE 044 046 CYSCKIT- 048
041-41XX
1 Sw2 PO[7] — P2[7] PO[7] PO[7] PO[7] PO[3]

A.6 Bill of Materials

Refer to the BOM files in the following paths in the kit software installed:

m <Install Directory>\CY8CKIT-041-40XX PSoC 4 S-Series Pioneer Kit\<ver-
sion>\Hardware\CY8CKIT-041-40XX PCBA BOM.xlsx

m <Install Directory>\CY8CKIT-041-40XX PSoC 4 S-Series Pioneer Kit\<ver-
sion>\Hardware\CY8CKIT-041-40XX Flex PCBA BOM.xlsx
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